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BÀI 23 NGÀY 14.9.2007 SOẠN THEO NGUYỄN TRƯỚNG SINH

SÁCH MACROMEDIA DREAMWEAVER 8  DO KS NGUYỄN TRƯỚNG SINH (CHỦ BIÊN ) CÙNG KS LÊ MINH HOÀNG VÀ KS TRẦN ĐỨC HẢI ĐƯỢC XUẤT BẢN THÀNH 2 TẬP . TẬP 1 GIÁ 62 NGÀN – TẬP 2 GIÁ 49 NGÀN . NẾU BẠN MUA TẠI NAM HOÀNG 217 Nguyễn văn Cừ ( Cổng Đại Học KHTN ) ĐT 8395.967 – 0903.397.605 – Sách giảm 25 -30% . NGOÀI RA TIẾP TỤC XUẤT BẢN QUYỂN PHẦN NÂNG CAO GIÁ 89 NGÀN. CÁC SÁCH NẦY VIẾT RẤT CHI TIẾT VÀ DỄ HIỂU . UTBINH ĐỌC SÁCH NẦY VÀ BỔ SUNG THÊM NHỮNG ĐIỀU MÌNH THU HOẠCH ĐƯỢC TRONG SÁCH . SÁCH NẦY CHỈ NÓI SƠ QUA KHÓ CHO NGƯỜI TỰ HỌC ,TỰ TÌM HIỂU . HY VỌNG UTBINH SẼ GIÚP ĐƯỢC CÁC BẠN VƯỢT QUA NHỮNG THẮC MẮC MÀ KHÔNG BIẾT HỎI AI . UTBINH PHÁT HIỆN RA RẰNG KS TRẦN ĐỨC AN TRƯỚC ĐÓ CŨNG ĐÃ RA MẮT QUYỂN : HỌC VÀ THỰC HÀNH THIẾT KẾ WEB CHUYÊN NGHIỆM DREAMWEAVER 8 , GIÁ 85 NGÀN. CÓ LẼ CÁC TÁC GIẢ NÊU TRÊN CÙNG DỊCH 1 SÁCH NÊN NỘI DUNG GIỐNG NHAU CÓ LẼ DỊCH TỪ HELP VÀ CÓ BỔ SUNG NÉT RIÊNG TƯ NHƯ UTBINH ĐÃ LÀM VẬY.

TRONG LÚC THAO TÁC CÓ THỂ BỊ XÁO TRÔN MÀ BẠN KHÔNG BIẾT LÀM CÁCH NÀO TRỞ VỀ TÌNH TRẠNG DEFAULT . UTBINH ĐỀ NGHỊ BẠN THỰC HIỆN CÁC CƠ BẢN SAU ĐÂY : TRỞ LẠI TRANG DEFAULT DESIGNER : WINDOW>WORKSPACE LAYOUT> DESIGNER HAY : VIEW > TABLE MODE > STANDARD MODE. MỞ LẠI TRANG KHỞI ĐỘNG : EDIT> PREFERENCES > GENERAL > TRONG DOCUMENT OPTIONS CHỌN SHOW START PAGE > OK. KHI KHÔNG MUỐN SỬ DỤNG TRANG KHỞI ĐỘNG : BỎ CHỌN SHOW START PAGE.

SITE CỤC BỘ ( SITE LOCAL )
Site Cục Bộ ( LOCAL SITE ) chứa các Folders và Files, hiện đang nằm trong ổ cứng của bạn. Chương trình Dreamweaver 8  có thể kết nối đến máy chủ Web Server bằng nhiều cách để Upload các Files – Folders trong site cục bộ. Host Server mà bạn đang dùng chứa các Files – Folders khi Upload lên nó phải có các đặc điểm sau:

1- Kết nối kiểu nào ? ( FTP – SFTP hoặc Web DAV )

2- Địa chỉ FTP, SFTP hoặc Web DAV của Host.

3- Account đăng nhập ( Username )

4- Password tương ứng .
5- Đường dẫn của Folders trên máy chủ chứa website .
I. Cách thức định nghĩa site ở xa với FTP và SFTP :
1- Chọn Site > Manage Sites > Ra bảng Manage Sites > chọn Site cần thiết > Nhấp Edit .
2- Ra bảng Editing Files > Next > Next > Next > Bạn cứ nhấp Next cho đến khi hiện ra bảng Sharing Files:

· How do you connect to your remote server ?

Chọn FTP > Nhập các trường. Đây là chọn kiểu kết nối FTP > Nhấp Test Connection (H1) .
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Cách chọn kiểu kết nối SFTP : Chọn FTP > Khai báo các trường > chọn hộp kiểm Use Scence FTP (SFTP) > Nhấp Test Connection > Không được, host có chức năng không cho phép sử dụng SFTP (H2) .
4- FTP, SFTP và Web DAV là gì ?

· FTP: File Transfer Protocol ( giao thức truyền tải tập tin ) từ ổ cứng lên server. Thông thường bạn dùng 1 phần mềm có chứa năng truyền tải FTP ( như Cute FTP chẳng hạn ). Dreamweaver đã tích hợp sẵn CT ứng dụng FTP. Giao thức này không có cài đặt sẵn tính bảo mật. Tất cả thông tin truyền đi “quá rõ ràng” kể cả tên người dùng, mật khẩu và cả tập tin. 
· Giao thức SFTP ( Secure FTP ) giải quyết vấn đề trên bằng cách mã hóa thông tin được gởi giữa ứng dụng SFTP ( trong trường hợp này là D ) và máy chủ SFTP.

· Giao thức Web DAV hỗ trợ tính bảo mật, bảo đảm 1 lần chỉ có 1 người có thể chỉnh sửa 1 trang web nào đó. Web DAV sẽ khóa tập tin khi nó đang được chỉnh sửa và mở khóa khi hòan tất trang. Dreamweaver có riêng hệ thống gồm thao tác khóa và mở khóa tập tin khi bạn sử dụng những giao thức không phải Web DAV.

II. Cách thức Định nghĩa Site ở xa với Web DAV :
1- Chọn Site > Manage Site > Nhấp Next liên tục cho đến khi hiện ra bảng Sharing Files

2- Trường: How do you connect to your remote server ? Chọn Web DAV > HT sẽ biến đổi để thể hiện các trường cần nhập thông tin cho kiểu kết nối Web DAV.

· Nhập URL của máy chủ Web DAV

· Nhập Username đăng nhập Web DAV

· Nhập Password mật khẩu Web DAV

· Chọn hộp kiểm Save

3- Nhấp thẻ Test Connection để Dreamweaver có thể kết nối thành công đến mày chủ Web. Nếu Dreamweaver báo lỗi, kiểm tra lại thông tin đã nhập > Next. Ở đây, Dreamweaver không kết nối được với Host Server của utbinh do Host này không có giao thức Web DAV (H3) .
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· Nếu kết nối Test thành công > Next > Màn hình Summary xuất hiện với thông tin đã nhập cho Site cục bộ và Site ở xa > Done.
III. Điều chỉnh định nghĩa Site :
Khi đã tạo các định nghĩa Site, bạn muốn thay đổi vị trí của Folder gốc cục bộ hay thay đổi đường dẫn trên máy chủ ở xa. Bạn dùng bảng Site Definition > Tab Advanced .
1- Menu Site > Manage Sites > Chọn Site cần thiết > Edit > HT Site Definition hiện ra > Tab Advanced.

2- Cột Category bên trái: Chọn kiểu thay đổi ( Ví dụ: Remote info ) > HT bên phải sẽ thay đổi để thể hiện các tùy chọn dành cho nhóm đã chọn > Test kiểm tra kết nối thành công hay không.

3- Nhập những phần thay đổi cần thiết > OK. (H4) .
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BẢNG ĐIỀU KHIỂN FILES
BĐK Files nằm bên phải, nằm dưới cùng của nhóm BĐK. BĐK Files gồm vài Menu bật lên -1 thanh công cụ và vùng bên dưới chứa các tập tin.

BĐK Files cho phép bổ sung và xóa bỏ các Files – Folders – Xem và thay đổi Site cục bộ hoặc ở xa – thực hiện thao tác duy trì Site.

Folder Site - 1 tạo lúc ban đầu ở Desktop, bạn tiếp tục tạo các Folders nằm trong Site -1 này, gồm: Folder Images – Lessons – Software – Index.htm
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Mô tả (H5) .
1) Di chuyển đến các ổ dĩa và Site

· Cách thức duyệt tìm trên ổ dĩa cứng :
· Nhấp Menu Browse > Hiện ra các ổ dĩa trong ổ cứng > Di chuyển đến Files và Folders cần thiết (H6) .
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· Cách thức chuyển đổi giữa các Site đã định nghĩa:
·  Nhấp Menu Browse > Nhấp chọn 1 site (H7) .
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2) Chuyển đổi giữa chế độ hiển thị cục bộ và ở xa :
· Chọn 1 site đã định nghĩa từ Menu Browse > Các tập tin của site xuất hiện trong vùng chứa tập tin và Menu File View 
( Menu hiển thị File ) bật lên sẽ chuyển sang chế độ Local View

( cục bộ ) .
· Từ Menu File View, chọn chế độ Remote ( ở xa ) .
· Dreamweaver sẽ kết nối đến Site ( chúng ta biết được vì nút nhấn Connect / Disconnect trong thanh công cụ được tô sáng và các tập tin ở xa sẽ xuất hiện trong vùng chứa tập tin .

(H8 + H9) .
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3) Làm mới các chế độ thể hiện :
· Khi chuyển đổi sang chế độ thể hiện cục bộ hay ở xa của 1 site, D sẽ quét nội dung của Folder trong site cục bộ hay ở xa và thể hiện nội dung hiện tại.

· Nếu tải lên hay xóa bỏ các đề mục trên site ở xa bằng 1 CT khác ( không phải Dreamweaver ), những thay đổi này không được thể hiện trong BĐK Files.

· Nếu di chuyển Files vào Folder gốc cục bộ bằng CT Window, các bạn cần thông báo để Dreamweaver quét lại và làm mới phần hiển thị site cục bộ.

Cách thức làm mới chế độ thể hiện cục bộ hoặc ở xa:
· Bật Menu Browse > chọn Site cần làm mới .
· Chọn Local View hay Remote View.

· Nhấp nút Refresh ( hình mũi tên vòng tròn )(F5). D sẽ quét lại Site được chọn và cập nhất vùng chứa tập tin. (H10) .
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4) Làm việc với tập tin (Files) và thư mục (Folders) :
BĐK Files rất hữu dụng để: Tổ chức tất cả các tập tin trên site – Tạo Files và Folders mới. Bạn nên tạo bằng D. 

Ví dụ: Tạo 1 trang mới : File > New > Chọn kiểu trang trong New Document và chỉnh sửa trang. Khi lưu HT, bạn phải di chuyển đến đúng Folder của site cục bộ, đặc tên cho trang , Save – để tạo 1 trang mới trong 1 Folder cụ thể bằng cách sử dụng BĐK Files , chọn Folder muốn lưu trang và chọn lệnh New File.
Cách thức tạo Files hay Folders mới:
1- Menu Browse > chọn Site cục bộ hay ở xa, thường tạo các Files và Folders trong site cục bộ.

2- Nhấp phải vào File hay Folder trong vùng chứa tập tin > Menu tắt xuất hiện và cung cấp nhiều tùy chọn > Chọn New File hay New Folder.

3- File hay Folder mới tạo sẽ xuất hiện trong vùng chứa tập tin. Nếu chọn Folder trong bước 2, File hay Folder mới sẽ được tạo trong Folder được chọn.

4- Tập tin mới sẽ được chọn, đặt tên.

5- Có thể nhấp nút Expand để thao tác. Cách này ít được chọn (H11) .
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Cách thức di chuyển Files và Folders:

1- Chọn 1 File hay Folder trong vùng chứa tập tin > Nếu muốn chọn nhiều giữ Ctrl và nhấp chọn từng thư mục > Rê đến  vị trí mới.

2- Hộp thọai Update Files xuất hiện > Update. D sẽ cập nhật tất cả liên kết trong site bị ảnh hưởng bởi thao tác di chuyển.

Cách thức đổi tên Files hay Folders: Chọn File hay Folder > Nhấp lên, nó được tô sáng > Nhập tên mới. Nhớ bổ sung phần mở rộng cho phù hợp tập tin đang đổi tên. Phần lớn có phần mở rộng tập tin là .htm hoặc .html > Enter > HT Update xuất hiện > Nhấp Update. D sẽ cập nhật.

Cách thức chỉnh sửa Files hoặc Folders:

· Nhấp phải lên File hay Folder > Edit > Chọn 1 trong sốcác đề mục của Menu Edit.

· Có thể dùng lệnh: Cắt – sao chép – dán – xóa bỏ - tạo bản sao – Đổi tên . Nếu thao tác ảnh hưởng đến tập tin khác, D sẽ hiển thị HT: “Are you sure?” hoặc HT Update.

Chú ý phím tắt trong Menu Edit và nên sử dụng cho quen.

Xuất và nhập tập tin :
· Bạn có thể sao chép các Files và Folders được chọn ( hay tòan bộ Site cũng được ) giữa Site cục bộ và Site ở xa. Thuật ngữ của D dùng mô tả di chuyển đề mục từ Site cục bộ đến Site ở xa gọi là Xuất đề mục.

· Nếu thao tác xuất và nhập ghi đè lên 1 tập tin, D sẽ cảnh báo.

· Nếu chọn 1 Folder, D sẽ di chuyển Folder và tất cả trong ruột của nó. Vì vậy nếu chọn Folder gốc cục bộ, bạn có thể xuất tòan bộ Site đến Máy chủ ở xa chỉ vài lần nhấp chuột.

· Thay vì xuất – nhập từng đề mục, nên chọn đặc điểm đồng bộ hóa Site của D.

Cách thức xuất và Nhập Files hay Folders:

1- Chọn chế độ thể hiện Local View hay Remote View > chế độ thể hiện cục bộ hay ở xa sẽ hiển thị trong vùng chứa tập tin.

2- Chọn File hay Folder cần di chuyển.

3- Nhấp nút Get File ( nhập tập tin ) hay Put File ( xuất tập tin ) trong thanh công cụ.

4- Nếu tập tin được truyền vẫn đang mở và chưa lưu những thay đổi, D sẽ hỏi bạn muốn lưu tập tin trước khi chuyển hay không ? Yes hay Yes to all.

5- D hiển thị: HT hỏi bạn có muốn truyền các tập tin phụ thuộc hay không. Ví dụ: Đó là các đồ họa trên trang đang tải lên. Nếu tập tin phụ thuộc đã tải lên máy chủ trước đó rồi thì nhấp NO.

Kiếm nhập và Xuất các tập tin:

Trong thanh công cụ có nút Check in ( kiểm nhập ) và Check out ( kiểm xuất )

Mở rộng BĐK Files

Nhấn nút Expant / Collapse ( mở rộng hoặc thu gọn ) trong thanh công cụ. Hiển thị chiếm tòan bộ màn hình. Nhấp nút này lần nữa, nó thu gọn lại (H12) .
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Đồng bộ Site cục bộ và Site ở xa
Việc có 2 bản sao: 1 trên máy cục bộ và 1 trên máy chủ web có thể phát sinh vấn đề.

Bạn có thể cập nhật 1 số trang trên Site cục bộ và không nhớ tập tin nào đã thay đổi nên không biết bản sao ở Site cục bộ hay ở xa, cái nào là phiên bản mới nhất.

Lệnh Synchronize của D sẽ so sánh Site cục bộ và Site ở xa 
( trong phần mềm Cute FTP cũng có ), rồi truyền những tập tin mới nhất cho Site kia ( Site chứa phiên bản cũ tập tin )

Cách thức đồng bộ Site cục bộ hoặc Site ở xa ( thực hiện 1 trong 2 cách ):

1- Nhấp phải vào BĐK Files > Từ Menu tắt chọn Synchronize.
2- Chọn Site > Synchronize Site Wide > HT Synchronize Files xuất hiện > Trường Synchronize chọn Entire … Site ( đồng bộ tất cả tập tin trong Site ).

· Selected Local Files Only ( chỉ những tập tin hay thư mục được chọn trong chế độ Local ) > Trường Direction, chọn cách thức muốn sao chép những tập tin mới nhất:

· Put Newer Files to Remote ( xuất những tập tin mới nhất đến Site ở xa ): truyền các tập tin mới nhất ở Site cục bộ đến máy chủ Web.

· Get Newer Files from Remote ( nhập những tập tin mới nhất từ Site ở xa ): tìm những tập tin mới nhất ở máy chủ Web và sao chép chúng về Site cục bộ. Tùy chọn này cũng sẽ sao chép tòan bộ những tập tin mới được tạo trên máy chủ Web ( Ví dụ do các đồng nghiệp gởi đến ) đến Site cục bộ.

· Get and put newer files ( nhập và xuất những tin mới nhất ): đồng bộ các tập tin theo cả 2 chiều. Những tập tin mới trên site cục bộ sẽ truyền đến Site ở xa và ngược lại

· Nếu cần hãy chọn hộp kiểm: “ Delete remote files not on local drive “ ( xóa bỏ các tập tin ở xa không có trên ổ dĩa cục bộ ). Đây là bước tùy chọn, bạn có thể thực hiện hoặc không (H13) .
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· Nhấp Preview xem trước.

3- Dreamweaver sẽ kết nối với Site ở xa và so sánh những tập tin được chọn để đồng bộ hóa, rồi hiển thị HT Synchronize. Thao tác này cho phép xem trước những thay đổi sẽ xuất hiện trên Site.

· Cột Action ( thực thi ) sẽ thông báo đề nghị thao tác của D đối với từng tập tin.

· Chọn 1 hoặc nhiều tập tin > chọn 1 trong những nút nhấn thực thi phía dưới HT:

· Get: nhập, tải xuống từ Site ở xa.

· Put: Xuất, gởi đến Site ở xa.

· Delete: xóa bỏ.

· Ignore ( bỏ qua ): Thông báo D bỏ qua những tập tin được chọn với thao tác đồng bộ hóa.

· Mark as Synchronize ( Đánh dấu như đã đồng bộ hóa ): Thông báo D xem những tập tin được chọn như đã được đồng bộ hóa, nên sẽ không có thao tác nào diễn ra.

· Compare ( so sánh ): mở ra phiên bản tập tin cục bộ và ở xa để so sánh sự khác biệt giữa chúng > OK. (H13a) .
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Giấu các tập tin :
· Không phải mọi thư mục trong Site cục bộ đều cần tải đến Site ở xa.

· Dreamweaver cho phép dấu các thư mục ( ví dụ: những tập tin Film chứa dụng lượng lớn ), nghĩa là chúng sẽ được lọai trừ khỏi thao tác đồng bộ hóa. Việc này giúp chúng ta tiết kiệm thời gian. Dreamweaver sẽ không mất nhiều thời gian khi quét qua thư mục khi đồng bộ hóa.

· Khi đã tải các tập tin lên, hãy mở khóa ( cho các thư mục chứa phim ) và thực hiện thao tác đồng bộ hóa.

Cách giấu thư mục của Site:

· Trong vùng chứa tập tin: Nhấp phải lên thư mục cần giấu > mở Menu con của Cloaking > CloaK > Thư mục bị gạch chéo cho biết đã được giấu đi. Mở ra: Chọn Uncloak hay Uncloak All.

· Bạn có thể dấu thư mục, nhưng không dấu từng tập tin riêng lẻ. Có thể khóa tất cả các tập tin có cùng 1 kiểu. Chọn Site > Manage Site > Chọn Site đang làm việc > Edit > Tab Advanced > Cột Category chọn Cloaking > kích họat Cloak Files Ending With ( giấu các tập tin với ) rồi nhập phần mở rộng tập tin để xác định kiểu tập tin cần giấu > OK. (H14) .
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